
MethodsX 11 (2023) 102446 

Contents lists available at ScienceDirect 

MethodsX 

journal homepage: www.elsevier.com/locate/methodsx 

Detailed protocol for a corneal thermal cauterization-based 

(lymph-)angiogenesis assay in mice 

✩ 

Anh-Co K. Truong 

a , Lisa M. Becker a , Nora Dekoning 

a , b , Ann Bouchéa , Koen Veys a , 
Baharak Hosseinkhani a , Mieke Dewerchin 

a , Guy Eelen 

a , 1 , Peter Carmeliet a , c , ∗ 

a Laboratory of Angiogenesis and Vascular Metabolism, Department of Oncology and Leuven Cancer Institute (LKI), KU Leuven, VIB Center for 

Cancer Biology, VIB, 3000 Leuven, Belgium 

b NanoHealth and Optical Imaging Group, Translational Cell and Tissue Research Unit, Department of Imaging and Pathology, KU Leuven, 3000 

Leuven, Belgium 

c Center for Biotechnology, Khalifa University of Science and Technology, Abu Dhabi, United Arab Emirates 

a r t i c l e i n f o 

Method name: 

Corneal thermal cauterization 

Keywords: 

In vivo (lymph-)angiogenesis model 
Ocular (lymph-)angiogenesis 
Corneal cauterization 
Whole-mount cornea immunofluorescence 
staining 

a b s t r a c t 

Angiogenesis and lymphangiogenesis, the formation of new blood or lymphatic vessels, respec- 
tively, from preexisting vasculature is essential during embryonic development, but also occurs 
during tissue repair and in pathological conditions (cancer; ocular disease; ischemic, infectious 
and inflammatory disorders), which are all characterized to a certain extent by inflammatory con- 
ditions. Hence, a rapid, inexpensive, feasible / technically easy, reliable assay of inflammation- 
induced (lymph-)angiogenesis is highly valuable. In this context, the corneal thermal cauterization 
assay in mice is a simple, low-cost, reproducible, insightful and labor-saving assay to gauge the 
role of inflammation in angiogenesis and lymphangiogenesis. However, to the best of our knowl- 
edge, there is no standardized protocol to perform this assay. Here, we provide a step-by-step 
description of the model’s procedures, which include: 

• The thermal cauterization of the corneas, 
• Enucleation and dissection of the corneas, 
• Subsequent immunofluorescence staining of the neovasculature, and morphometric analysis. 

We also discuss ethical considerations and aspects related to animal welfare guidelines. Alto- 
gether, this paper will help to increase the reproducibility of the corneal thermal cauterization 
model and facilitate its use for angiogenesis and lymphangiogenesis research. 
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Specifications table 

Subject area: Agricultural and Biological Sciences 
More specific subject area: Angiogenesis and lymphangiogenesis 
Name of your method: Corneal thermal cauterization 
Name and reference of original method: No reference of original method 

Resource availability: Low-temperature cautery kit: 
https://www.wpi-europe.com/products/microdissection/surgical-instruments-under- 
construction/applications/electrosurgery/disposable-cautery/low-temperature- 
cautery.aspx#productlistitem2422 
Rat anti-mouse CD31 antibody: https://www.bdbiosciences.com/en-be/products/reagents/flow- 
cytometry-reagents/research-reagents/single-color-antibodies-ruo/purified-rat-anti-mouse-cd31.557355 
Rabbit anti-mouse LYVE-1 antibody: http://www.angiobio.com/new/product.php?pid = 8 
Cy TM 3 AffiniPure Donkey Anti-Rat IgG (H + L): 

https://www.jacksonimmuno.com/catalog/products/712-165-153 
Donkey anti-rabbit IgG (H + L) highly cross-adsorbed secondary antibody, Alexa Fluor TM 488: 
https://www.thermofisher.com/antibody/product/Donkey-anti-Rabbit-IgG-H-L-Highly-Cross-Adsorbed- 
Secondary-Antibody-Polyclonal/A-21206 
ImageJ software: imagej.net 

Method details 

Introduction 

Angiogenesis and lymphangiogenesis, the formation of new blood and lymphatic vessels, respectively, from pre-existing ones, is 
regulated by a balance between pro- and anti-(lymph-)angiogenic factors [1–3] . In adult humans, (lymph-)angiogenesis only occurs 
in certain physiological conditions, for example in the context of wound healing, or endometrial growth during the menstrual cycle
[3–5] . In adult disease conditions, (lymph-)angiogenesis occurs in cancer, inflammatory / infectious diseases, ischemic conditions, or 
ocular diseases, to name a few [ 1 , 3 , 6 , 7 ]. Thus, robust, feasible, rapid and insightful in vivo models are needed to study the respective
role of inflammation in (lymph-)angiogenesis during these disease conditions. 

The mouse cornea has been widely used as a preclinical model for in vivo angiogenesis and lymphangiogenesis studies, in part
because the cornea is normally avascular, and at the same time, allows easy monitoring and quantification of the experimentally
induced vascularization process [8–10] . Corneal (lymph-)angiogenesis can be induced in a standardized manner via administration 
of inflammatory or angiogenic agents such as growth factors, cytokines, (tumor) tissue extract, or by inflicting tissue damage ( e.g.

infection, suture, cauterization) [9] . Therefore, established corneal (lymph-)angiogenesis assays, such as the corneal pocket assay 
(based on local administration of growth factors) and corneal cauterization ( e.g. local alkaline treatment, chemical injury, thermal
cauterization), which have been used to study (lymph-)angiogenesis in a preclinical context, are considered to be quantitative and
reproducible [ 6 , 8 , 10–13 ]. In comparison to other corneal (lymph-)angiogenesis assays, thermal cauterization offers advantages of low
costs, speed, the lack of need for complicated tools, and the relatively easiness for experimentalists to learn the technique. Notably,
this assay is characterized by an inflammatory response that often accompanies and contributes to pathological (lymph-)angiogenesis 
[ 1 , 3 ]. Importantly, the insights gained from corneal (lymph-)angiogenesis models have been translated into clinical contexts. For
instance, the role of ketone bodies in lymph-angiogenesis was discovered using a thermal corneal cauterization model, which was
subsequently replicated in myocardial infarction and lymphoedema models [12] . Notably, this study led to a clinical trial using
ketone bodies to treat lymphoedema in breast cancer patients (NCT03991897), demonstrating the translational potential of findings 
obtained using the thermal corneal cauterization assay, and proving its value as a preclinical (lymph-)angiogenesis model. 

While several protocols for the corneal pocket assay or suture assay are published, to date, there is no detailed protocol available
about corneal thermal cauterization [ 8 , 10 , 11 ]. Here, we describe in detail a standardized protocol for the corneal thermal cau-
terization assay, including the procedures of thermal corneal cauterization, potential treatment approaches, cornea dissection and 
subsequent downstream immunohistological and morphometric analyses. We also point out practical tips and critical steps requiring 
extra caution and discuss ethical aspects that need to be considered. The availability of a detailed, standardized experimental proto-
col will increase reproducibility and will facilitate direct comparison between different studies across different research teams in the 
angiogenesis and lymphangiogenesis field. 

Materials and equipment 

Corneal cauterization and dissection 

o Animals: 8- to 12-week-old, untreated C57BL/6 mice 
o Reagents: 

▪ Ketamin (Nimatek 100 mg/mL, Dechra, BE-V439546) 
▪ Xylazin (XYL-M 2 %; V.M.D, BE-V170581) 
▪ Saline (NaCl 0.9 %, B. Braun) 
▪ Unicaine 0.4 % (Théa Pharma) 
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▪ Terramycine + Polymyxine B ointment (Pfizer) 
▪ Buprenorphine 0.3 mg/mL (Vetergesic R ○ Multidose, Ceva Animal Health) 
▪ Phosphate-buffered saline (PBS) 
▪ 70 % ethanol 

o Surgical tools: Sterilized with hot beads sterilizer for ± 20 s before use. 

▪ Low temperature cautery kit with disposable monopolar tip (World Precision Instruments, 500391). 
▪ Dumont SS forceps (Fine Science Tools, 11203-25) 
▪ Extra fine Graefe forceps (Fine Science Tools, 11151-10) 
▪ Dumont fine forceps #5 (Fine Science Tools, 11252-20) 
▪ Dumont forceps #5/45 (Fine Science Tools, 11251-35) 
▪ Curved student Vannas spring scissor (Fine Science Tools, 91501-09) 
▪ Vannas Spring Scissors – 2.5 mm (Fine Science Tools, 15000-08) 

o Equipment 

▪ Binocular stereozoom microscope (Leica Biosystems, Wild M3Z and EZ4 or equivalent) 
▪ Surgical pad 
▪ Rodent heating pad 
▪ 48-well plate 
▪ 10 cm Petri dishes 
▪ Cotton swabs 
▪ Gauze 
▪ 1000 μL micropipette or plastic pipette dropper 

Whole-mount cornea immunofluorescence staining: 

o Reagents 

▪ PBS 
▪ 3 % BSA and 3 % Gloria milk in PBS 
▪ 1 % BSA in PBS 
▪ Rat anti-mouse CD31 antibody (BD Biosciences, 557355) 
▪ Rabbit anti-LYVE-1 antibody (AngioBio, 11-034) 
▪ Donkey anti-rat IgG, Cyanine 3-conjugated (Jackson ImmunoResearch, 712-165-153) 
▪ Donkey anti-rabbit IgG, Alexa Fluor TM 488-conjugated (ThermoFisher Scientific, A-21206) 
▪ ProLong Gold without DAPI (Invitrogen, P36934) 

o Equipment 

▪ Orbital-rocking shaker (GFL, 3011) 
▪ Adhesion microscope slide (Epredia, J1800AMNZ) 
▪ Glass coverslip (VWR, 631-0146) 
▪ Sharpoint 22.5° stab knife (Angiotech, 72-2201) 
▪ Fluorescence microscope (Leica Biosystems, DMI6000B or equivalent) with filter cube appropriate for visualization of the fluo- 

rochromes used (e.g Cyanine 3 and Alexa Fluor TM 488) 

Protocol 

Depending on the aim of the study, the technique can be applied to different mouse strains. For instance, when investigating the
roles of a specific gene during (lymph-)angiogenesis, one may use transgenic knockout mice and their wild-type counterparts (see 
Step 1.9). In this paper, wild-type C57BL/6 mice were used as an example. Animal housing and all experimental procedures were
approved by the Institutional Animal Ethics Committee of the KU Leuven (Belgium). 

Step 1: Thermal corneal cauterization ( ± 5 min per mouse) 

1.1. The mouse surgeon wears appropriate attire, including a clean lab coat, face mask and cap. Surgical gloves must be worn for
surgery only, avoiding touching anything other than surgical tools while wearing gloves. Between each animal, surgical gloves 
are changed. 

1.2. Set up a surgical area under a binocular surgical stereomicroscope (Leica Wild M3Z or equivalent): 

• Sterilize area with disinfectant (e.g. 70 % ethanol) and place a sterile surgical pad under the microscope. Note that the surgical
pad will be changed for each animal to ensure the sterility for each procedure. 

• All necessary surgical tools (see Materials and equipment section) have to be sterilized (e.g. using a hot bead sterilizer for
± 20 s) before the use in each animal as sterilization between animals is necessary. Note that the sterilization process should
be in line with the aseptic guidelines of the host institution. 
3 
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• Lay out the sterilized tools on another sterile pad next to the microscope and the surgical pad. 
• Ensure adequate lighting for the surgery area. 

1.3. Anesthetize the mouse by intraperitoneal injection of a mixture of ketamine (100 mg/kg body weight) and xylazine (10 mg/kg
body weight) in saline. This will keep the mouse unconscious for 30–60 min. 

Note: A maximum of 5 mice should be anesthetized at a time to avoid that mice gain consciousness during the surgery. 
Note: Wait 15 min for the mice to be fully anesthetized before starting surgery. It is imperative to ensure that anesthesia is

sufficiently deep and the mouse does no longer react to any pain stimuli caused by pinching its toe, tail or ear. Any retraction
of the foot, or movement of the tail or ear indicates a reaction to the stimulation; the animal is not yet ready for surgery. 

1.4. After ensuring systemic anesthesia, place the mouse in a lateral recumbent position on the sterilized surgical pad under the
microscope so that the to be cauterized eye faces upwards. Add a drop of local anesthetic (Unicaine 0.4 %) fully covering the
to be cauterized eye for no more than 30 s. Then wipe the excess anesthetic off using a sterile cotton swab. 

Note: Limit the contact time of the cornea with Unicaine as this will cause corneal irritation. 
Note: To prevent the intact eye from drying out over the duration of anesthesia, ophthalmic drops should be applied to the intact

eye. This is not necessary for the cauterized eye, as the antibiotic ointment applied in Step 1.6. will keep the eye hydrated. 

1.5. Visualize the to be cauterized eye under the microscope. Gently use the Graefe forceps to slightly squeeze the eyeball out of
the eye socket. With the other hand, use the ophthalmic cauterizer with a monopolar tip to perform the cauterization in the
central part of the cornea by swiftly touching the tip of the cauterizer to the cornea. Importantly, the size of the burn should
not be bigger than the size of the cauterizer tip. Start the first burn in the middle of the cornea (middle of the pupil), followed
by making edge-to-edge adjacent burns on three concentric circumferences around the first burn, as demonstrated in Fig. 1 A.
The adjacent burns should not overlap the existing ones to prevent overburn, however, the circumferential burn cycles should 
align edge-to-edge to the previous cycle. 

Note: Do not put the Graefe forceps directly on the eyeball. Some eyelid tissue should be included when grabbing the eyeball. 
Note: The cautery kit used here is designed as a pen with a heat-insulating handle and a burning tip. To limit the risk of self-burn,

hold the kit handle with one hand and the mouse eye using the forceps with the other hand, as previously described. The
cautery pen should be held perpendicularly to the cornea surface. 

Note: Cautery equipment should be turned on 5 min in advance to reach the optimal temperature. An underheated cautery tip
can stick to the cornea, resulting in a tear of the cornea or even in bursting of the eye. To verify whether the temperature level
is optimal, place the tip of the cauterizer in a drop of water on a petri dish. The kit is ready to use when boiling air bubbles
appear from the heated tip. For the kit used here, there is no temperature adjustment and the temperature is around 700°C.
If another kit is used, it is necessary to ensure that the temperature is set to 700°C as default settings may vary depending on
the type of cauterizer used. 

Note: Inflicting the burns of the cauterizer tip to the cornea should be performed swiftly in less than one second per burn spot.
Prolonged burns can result in deep injury which cannot be recovered. 

Note: Take caution while executing the cauterization not to burn the entire cornea. The burns should cover no more than about
80 % of the cornea, as demonstrated in Fig. 1 A. This is ensured if the cycles are as close as possible next to each other (edge-to-edge).
In addition, it is recommended to perform cauterization unilaterally, leaving one eye intact to preserve sufficient eyesight for the
animal. The contralateral non-injured eye can serve as a control, either healthy or treatment without injury. Alternatively, depending 
on the ethical guidelines of the researcher’s institute, and given that the injured eye regains transparency by day 3 post-injury and
largely restores eyesight, cauterization of both eyes may be considered. This approach enables the use of one eye for the treatment
and the contralateral eye for vehicle or control treatment (see also Step 1.9 for more discussion of these options). 

1.6. Add Terramycin + Polymyxine B antibiotics ointment directly on the cauterized eye and let the mice recover on the heating
pad (37°C) until they are fully conscious. 

1.7. Once the mice gain their full consciousness, inject the mouse intraperitoneally with Vetergesic R ○ analgesic (0.05 mg/kg) to 
reduce the pain. 

Note: Treatment with Vetergesic R ○ analgesic could affect immune responses of the mice, which should be taken into account if
the assay is used in immunological studies [14] . 

Note: Depending on the ethical guidelines in each country and institution, analgesics may be applied already before mice gain
consciousness. 

1.8. Apply the treatment of Terramycin + Polymyxine B antibiotics ointment (directly on the cauterized eye) and Vetergesic R ○

analgesic (intraperitoneal injection) every 12 h for 2 days post-surgery. 
Note: Terramycin + Polymyxine B antibiotics ointment should fully cover the cauterized eye. As this is a simple topical admin-

istration, the ointment will be eventually cleaned off by the mice. Therefore, it is necessary to apply antibiotics every 12 h,
during the first 2 days, until the burns are totally recovered. 

1.9. Monitor the mice daily, for 7 days. During this post-surgery period, new vessels will grow from the limbus towards the
cauterization injury. Longer time periods can lead to an overgrowth of vessels that may impair subsequent analysis. Different 
treatments to study the involvement of a particular gene / gene product in (lymph-)angiogenesis can be performed during the
monitoring period. Treatments of the cauterized eye can start on the day of or one day post-induction of the injury. Examples
of potential treatment strategies include: 
4 
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Fig. 1. Cornea thermal cauterization procedure. (A) Scheme of cauterization steps starting with a central burn, followed by three consecutive 
concentric circumferences of burns. (B) Handling guidance of using Dumont SS forceps and curved Vannas spring scissors to enucleate the eyeball: 
the curved Dumont SS forceps is placed on the sides of the eyeball and slowly slid towards the back of the eyeball to displace it from the eye socket 
and to expose the optic nerve behind the eyeball. The curved Vannas spring scissors held in the other hand can then be used to cut off the nerve 
behind the eyeball. (C) Microscopic images of the enucleated eyeball before the removal of sclera and choroid. (D,E) Microscopic image of the 
cornea and iris tissue before (D) and after (E) the removal of retina and lens. Cornea, iris, sclera, choroid, retina and lens are indicated. The limbus 
is indicated with a white dashed line. The figure in panel A was created with BioRender.com. 

5 
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• Topical application of an siRNA solution targeting a gene of interest, once daily for several consecutive days to silence a particular
gene in all corneal cells including the forming neovasculature [15] . 

• Ophthalmic drops containing a target-specific inhibitor, applied once daily after the induction of corneal injury [13] . 
• Corneal intrastromal or subconjunctival injection of adeno-associated viral vectors encoding anti-angiogenic factors or direct 

intrastromal injection of antisense oligonucleotides into the cornea [ 16 , 17 ]. 
• Alternatively, the involvement of novel candidate (lymph-)angiogenesis genes can be studied using vascular endothelial-specific 

knockout mice (if available). 
• To obtain a local gene knockout, a plasmid expressing Cre-recombinase can be injected intrastromally, or a cell-permeable,

active Cre-recombinase protein (diluted in PBS) can be added to topical ophthalmic drops, which can then be applied onto the
cornea of gene-floxed mice [18] . Of note, a local gene knockout can avoid undesired systemic effects on corneal vascularization
and/or general animal welfare, resulting from a gene knockout in ECs in all organs/tissues. 

Note: The application of the negative control treatment condition will depend on whether one or both eyes of an animal are
injured (see the discussion of ethical concerns in the section Ethical considerations). (i) In case both eyes of the animal are
injured, treatment with control condition (control siRNA/ shRNA, vehicle, or no application of Cre-recombinase, depending on 
the treatment approach) can be done on the contralateral injured eye of the same animal. (ii) In case only one eye is injured,
the contralateral non-injured eye can receive the same treatment as the injured eye and may serve as a toxicity control, while
the negative control treatment will require vehicle treatment on an injured eye of another animal. This approach may therefore
be associated with larger variations in the treatment outcome due to variable responses of the animals, and at least double the
number of mice have to be used to properly control an experiment. However, the injury of only one eye avoids temporary loss
of eyesight due to the cauterization. 

Note: Frequency and dose of the treatments may vary depending on the drugs/treatment systems used. 
1.10. Euthanize the mouse after 7 days and perform cornea dissection (see Step 2). 
Step 2: Cornea dissection ( ± 15 min per mouse) 

2.1. Anesthetize the mouse by intraperitoneally injecting a mixture of ketamine (100 mg/kg body weight) and xylazine (10 mg/kg
body weight) in saline, as described in Step 1.3. Once anesthesia is ensured, euthanize the mouse by cervical dislocation. 

Note: Cauterized eyes are very fragile and can easily burst, which makes the dissection of the cornea challenging. Thus, mice
should be anesthetized before they are euthanized, and cervical dislocation should be performed with care as too much pressure
on the head could damage the eye. Thus, the pressure on the neck of the animal should only be strong enough to dislocate
the spinal column from the skull. Therefore, while pulling the tail, start with low pressure and observe the eyes of the mice to
ensure they are not bursting. If no dislocation is achieved, pressure can be slightly increased. 

2.2. Place the euthanized mouse in a lateral recumbent position on a flat and smooth surface so that the cauterized eye faces
upwards. Gently place the two tips of the curved Dumont SS forceps on both sides of the eyeball, and slowly slide them
towards the back of the eyeball to displace it from the eye socket, which exposes the optic nerve behind the eyeball ( Fig. 1 B).
Then, with the other hand, place the curved Vannas spring scissors behind the eyeball to cut off the nerve, thereby detaching
the eyeball ( Fig.1 B). Once the eyeball is detached from the socket, place it in 500 μL of pre-chilled PBS (48-well plate). Place
the plate containing the enucleated eyeball on ice to keep the PBS cold. 

Note: Gentle and careful handling is required for this enucleation step. The eyeball should not be squeezed with the forceps, but
rather placed on top of the inner curved side of the forceps by sliding them under the eyeball, as described above. 

2.3. Continue with the enucleation for all the mice. Once all eyeballs are enucleated, dissection of the corneas is performed. 
2.4. Prepare a piece of gauze covered with 2 mL of pre-chilled PBS in a petri dish. Place the petri dish on ice to keep the PBS cold.
2.5. Use the Dumont SS forceps to grab the eyeball (by sliding the forceps carefully under the eyeball) and place it on the gauze in

the prepared petri dish. Under a binocular surgical stereomicroscope (Leica EZ4 or equivalent), use the Dumont fine forceps #5
to hold the eyeball in place, and with the other hand, use the Vannas spring scissors to remove the muscle tissue surrounding
the eye. Here, slowly cut the muscle tissue off the eyeball without touching the eyeball with the scissors. 

2.6. Continue using the Dumont fine forceps #5 to hold the eyeball in place. With the other hand, use the Vannas spring scissors
to first make a small incision in the sclera, just below the limbus. Then, through the incision, cut off the sclera and the choroid
from the eyeball ( Fig. 1 C). 

2.7. Continue using the Dumont fine forceps #5 to hold the eyeball in place, and with the other hand, use curved forceps #5/45
to gently pull the retina and the lens apart from the cornea and iris part ( Fig. 1 D,E). 

2.8. Carefully remove the remaining iris tissue at the edge of the cornea by holding the iris with the curved forceps #5/45 and
holding the cornea with the Dumont fine forceps #5, then gently pulling the iris tissue off the cornea. Put the cornea in another
48-well plate containing 500 mL of pre-chilled PBS in each well. Place the plate containing the dissected cornea on ice to keep
the PBS cold, and continue the dissection of all corneas. 

2.9. After dissection of all corneas, remove the PBS using a 1000 μL micropipette or a plastic pipette dropper. Be careful not to
touch the corneas with the pipette. Add ethanol 70 % to fix the corneas for 1 h at room temperature in the same 48-well plate.
Use the fixed corneas for immunostaining to visualize the blood and lymph vessels (see Step 3). 

Step 3: Whole-mount cornea immunofluorescence staining ( ± 24 h) 

The procedure describes the combined visualization of angiogenic and lymphangiogenic neovascularization. 

3.1. After 1 h fixation in 70 % ethanol, wash the corneas in PBS for 30 min at room temperature, by using the curved forceps
#5/45 to transfer the corneas to a new 48-well plate with PBS. 
6 
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3.2. Remove the PBS from the corneas using a plastic pipette dropper, then add PBS containing 3 % BSA and 3 % Gloria milk to
block the tissues and place the plate on an orbital-rocking shaker for 1 h at room temperature. 

3.3. Remove the blocking solution using a plastic pipette dropper, prior to incubating the corneas with rat anti-CD31 antibody
(BD Biosciences 557355, 1:200) and rabbit anti-LYVE-1 (AngioBio 11-034, 1:100) in PBS containing 1 % BSA on the shaker
(with mild continuous agitation) overnight ( ± 18 h) at room temperature. Note that there are no washing steps between the
removal of the milk and adding the antibody solution. 

3.4. After the overnight incubation, remove the antibody solution using a plastic pipette dropper, then add PBS to the corneas
and wash on the shaker for 1 h at room temperature. 

3.5. Remove the PBS using a plastic pipette dropper, then incubate the corneas with donkey anti-rat – Cyanine 3 (Jackson Im-
munoResearch, 712-165-153, 1:200) and donkey anti-rabbit – Alexa Fluor TM 488 (ThermoFisher Scientific, A-21206, 1:200) 
in PBS containing 1 % BSA on the shaker for 2 h at room temperature. 

3.6. Remove the antibody solution using a plastic pipette dropper, then wash the corneas in PBS on the shaker for 1 h at room
temperature. 

3.7. Remove the PBS from the corneas using a plastic pipette dropper, then use a stab knife to make four ± 1 mm radial incisions
from the limbus towards the center of the cornea to produce a “cloverleaf-shaped ” flat cornea as demonstrated in Fig. 2A .
Flat-mount the stained corneas on glass microscope slides by adding a drop of anti-fade ProLong Gold on each cornea and
cover with a glass coverslip ( Fig. 2A ). 

Note: When changing different solutions, avoid touching corneas with the pipette/pipette dropper. 
Note: While mounting, avoid formation of bubbles under the coverslip. Let the mounted slides dry at room temperature for at

least one hour. 
3.8. Take images of the corneas using a fluorescence microscope (Leica Biosystems, DMI6000B or equivalent) with the filter cube

appropriate for visualization of the fluorochromes used (Cyanine 3 and Alexa Fluor TM 488) ( Fig. 2 B). 

Note: Here, a tile scan microscope method with 10X objective can be used to record adjoining single images which can be arranged
in the form of a grid to cover the entire cornea specimen. The tiles should overlap 2-10 % versus one another, enabling the mosaic
function to stitch the tiles into a correct and complete mosaic image of the entire cornea. We recommend the use of a microscope
software program that has incorporated this function ( e.g. Leica Application Suite Advanced Fluorescence – LAS AF). 

Note: A length scale indicating a known distance of the resulting mosaic images should be included for the subsequent analysis
in Step 4. 

Note: In case a microscope equipped with mosaic imaging is not available, it is recommended to take non-overlapping microscopic
images with a 10X objective. At least 5 images should be taken over the 4 “cloverleaf-shaped ” lobes of the cornea. Each image should
cover the whole length of the vessels, from the limbus to the middle of the cornea. A length scale should be included for the subsequent
analysis. 

Step 4: Quantification of vascularization 

In our protocol, ImageJ software (imagej.net) was used for the quantification of the vascularized area in the corneas. Briefly, the
quantification can be performed with the following steps: 

4.1. Firstly, load the cornea image in the ImageJ software (File > Open > Select the cornea image, or simply drag the image onto
the ImageJ interface). 

4.2. Define the scale of the image by drawing a straight line corresponding to the length of the scale bar using the Straight tool. Use
Analyze > Set scale tool to set the distance in pixel (automatically measured by the software) to the known distance (indicated
in the scale bar). Check “Global ” to apply the same scale to all the subsequent images. 

Note: Unit of length should also be adjusted, according to the unit indicated in the scale bar of the image. 
4.3. Set measurements of interest (Analyze > Set measurements > Check the boxes for "Area ” and “Limit to Threshold ”). 
4.4. Measure the area of the cornea: Select the corneal region of interest (ROI) by using Polygon selection or Freehand selection

drawing tool. Measure the area of the whole cornea ROI (Analyze > Measure). 
4.5. Split the double stained image into separate channels (Image > Color > Split channels). As a result, each staining channel

will be presented in a separate image window ( Fig. 2 C and E). 
4.6. Measure the blood vessel area: Select the image window of CD31 staining (red channel in our example). Set a grey value

threshold (Image > Adjust > Threshold) by adjusting the minimum threshold at which the positivity signal covers most of the
CD31 + area but not the background ( Fig. 2 B, white arrows, and 2D ). Select “Default ”, “Red ” and check “Dark background ”
parameters for the output image. Click “Apply ”, followed by Analyze > Measure to measure the CD31 + area within the selected
corneal ROI. Then, copy the measured values into a spreadsheet ( e.g. using Microsoft Excel), use the “Area ” value of CD31 + 

area and that of the cornea area (from Step 4.4) to calculate the percentage of angiogenic vascularization in the entire cornea.
Note: The same threshold should be applied to the CD31 channel over all cornea images of the same experiment. 
Note: To reduce false positive and false negative signals when adjusting the threshold, a filter sampling method, such as the one

developed by Bock et al. could be applied to obtain a more distinct grey value of the vessels [19] 
4.7. Measurement of lymphatic vessel area should be performed similarly to that of the blood vessel area in Step 4.6, with the

selection of the image window of the LYVE-1 staining (green channel) ( Fig. 2 B, yellow arrows, and 2F ). 
Note: A different grey value threshold from that of the CD31 staining can be applied for the LYVE-1 staining. Similarly, this

threshold should be kept unchanged for this channel over all images of the same experiment. 
7 



A-C.K. Truong, L.M. Becker, N. Dekoning et al. MethodsX 11 (2023) 102446 

Fig. 2. (A-B) Representative image of a “cloverleaf-shaped ” flat-mounted cornea (A) and representative fluorescence image of a cornea, whole-mount 
immunostained for CD31 (red) and LYVE-1 (green) to respectively visualize the blood (white arrows) and lymphatic (yellow arrows) neovasculature 
(B). The image in panel B is a mosaic image taken on a Leica DMI6000B microscope equipped with LAS AF for mosaic imaging. The tiles were taken 
using a 10X objective. Scale bar 500 μm. (C-D) Representative images of CD31 + channel: original (C) and with adjustment of grey value threshold 
(D). (E-F) Representative images of LYVE-1 + channel: original (E) and with adjustment of grey value threshold (F). The blood and lymphatic vessel 
morphometry was performed using the threshold tool of ImageJ. 
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4.8. Quantify the branch points of the vessels: In ImageJ, use the magnifying glass tool to zoom into the CD31 image for a close-up
visualization of the blood vessel branches. Use Multi-point tool to mark all the blood vessel branch points within the cornea.
Repeat on adjacent zoom-in areas until the whole cornea is counted. Then, calculate the branch point density by dividing the
number of counted points by the previously measured cornea area ( “Area ” value) in Step 4.4. Similar quantification can be
performed with the LYVE-1 image for the number of lymphatic branch points. 

Note: The Multi-point tool can be selected from the drop-down box, which can be accessed by right-clicking on the Point tool
button of the ImageJ tool bar. The points added to the image will automatically remain and be numbered. Type, color, size and
label of the points can also be adjusted in a configuration window, which is opened by double-clicking on the Multi-point/Point
tool button (or Edit > Options > Point tool). 

Note: The two-dimensional microscopic images may cause difficulty in distinguishing genuine vessel branch points from crossings 
of superposed vessels located in different focus planes. Therefore, it is easier to define the branch point by following the growth
of vessels from the limbus, rather than only counting any crossing points, thereby minimalizing the number of incorrect counts.

Note: Examples of end results of these quantifications can be viewed in Figure 2b-c and 2h-i of the related research article [12] . 

Ethical considerations 

While guidelines for animal procedures differ between countries and institutions, there are a few general points to take into
consideration to minimize the numbers of animals needed to obtain meaningful and valid results (see Statistical considerations), to
reduce discomfort and pain, and to maximize animal welfare throughout the assay procedures. Once the relevance of applying the
assay to address a specific biological question and/or its translational purpose is established, one may want to consider the following
points, which may also be of relevance when applying for ethical approval. 

▪ According to the ARVO guidelines, this experimental design falls under a major survival surgery, therefore we recommend to
perform this experiment in one eye only, while leaving the other one intact in order to minimize the visual disability that
is temporarily inflicted by the cauterization injury. However, depending on national/institutional ethical guidelines regard- 
ing animal experimentation, bilateral eye injury may or may not be permitted. We have taken this into consideration when
describing the treatment approaches that can be applied using the corneal cauterization model, and listed the respective dis- 
advantages and advantages of application of bilateral or unilateral eye injury ( e.g . differences in degree of visual disability;
lower or larger variation in treatment effects; number of animals needed; see Section 1.9). 

▪ During surgery: 

o Appropriate pre-emptive anesthesia strategies for the management of ocular pain should be incorporated in the study design 
( e.g. Ketamine/Xylazine injection, Unicaine drop of local anesthetic). 

▪ After-surgery care: 

o Directly after the surgery, the mice should be closely monitored until they fully regain consciousness, and twice daily for
the first two days post-surgery. 

o Analgesics ( e.g. Vetergesic R ○) should be applied once animals regain their full consciousness. Depending on the guidelines of
the institutional animal welfare guidelines, analgesics can also be applied before animals gain consciousness. 

o This cauterization method can cause partial visual disability and irritation for up to 48h post-surgery. Therefore, food
should be placed on the floor of the cage for easier access, for at least 48h post-surgery. Moreover, an additional source for
hydration, such as hydrogel, should be placed on the cage floor. At day 3 post-surgery, most of the burn spots will recover
and the corneas will regain their transparency. 

o Throughout the experiment, mice should be monitored at least once daily. If signs of acute pain are noticed ( e.g. hunched
posture, lack of eating/drinking, lack of grooming, isolation from other animals in the cage, etc.), analgesics can be applied
for longer periods than the 2 days, as mentioned in Step 1.7, and at shorter time intervals ( e.g. 8 h). 

Statistical considerations 

The main outcome of this experiment is the extent of corneal neo-vascularization in a control group compared to an experimental
group (animals with (conditional) gene knockdown/knockout or silencing induced via siRNA/viral vector treatment, or by using 
transgenic animals, or animals receiving a certain treatment, etc). As in all in vivo assays, slight differences in the response of individual
mice, and slight differences in the inflicted cauterization area, can create some variation between the biological repeats within a
condition. Thus, when designing an experiment, group sizes need to be carefully considered in order to ensure that reproducible,
statistically significant data are obtained with sufficient power. This can be defined using power calculations based on previous data.
A key parameter for evaluating vascularization is the quantification of the vessel area in the cauterized cornea, as described in Step 4.
Based on our previously published [12] and unpublished studies, we expect the mean vascularized area in control animals (C57BL/6
wildtype, untreated mice), expressed in % of total corneal area, to be around 25 % with a standard deviation of 5.5 (this example
refers to the lymphangiogenic vascularization). When comparing a control group to a manipulated group, one can then calculate the
effect size upon defining a difference between the two experimental groups that one considers to be biologically meaningful in the
particular experimental context ( e.g. a reduction by 40 %). 
9 
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Based on the calculated effect size, the sample size can be calculated with a statistical software program ( e.g. G 

∗ Power,
https://www.psychologie.hhu.de/arbeitsgruppen/allgemeine-psychologie-und-arbeitspsychologie/gpower.html ) for two-sided t-test, 
using 80 % power (or 90 % if more stringent conditions are preferred) and alpha error of 0.05. As an example, using the above listed
control angiogenic area values and considering a 40 % reduction of the vascularization area upon treatment as biologically meaning-
ful, input parameters in G 

∗ Power for this example are as following: 

o Test family: t-test; 
o Statistical test: Means: Difference between two independent means (2 groups); 
o Mean group 1: 25; 
o Mean group 2: 15; 
o SD within each group: 5.5 (used here as a common SD for both groups). 

With these parameters, the calculated effect size is 1.818. When a two-tailed test with 80 % power and alpha error of 0.05 is
applied, the calculated group size is then 6. With the help of power calculations, the design of the experiment can be optimized by
computing the minimal group size needed to obtain reliable, well-powered results, thereby avoiding the use of excess, unnecessary 
animals. 

Conclusion and remarks 

Ideally, the in vivo study of (lymph-)angiogenesis to identify novel (lymph-)angiogenic drivers and thus potential clinical targets, 
should be rapid and easy-to-monitor. For these reasons, the transparent and avascular mouse cornea is a suitable model that allows
rapid procedures for the induction of blood and lymphatic vessel formation [8–10] . Thermal injury of the cornea induces all hallmarks
of (lymph-)angiogenesis: it promotes the recruitment of polymorphonuclear leukocytes, which provide a continuous source of pro- 
angiogenic cytokines and growth factors, thereby triggering the formation of new blood and lymphatic vessels from the limbal area
towards the cauterized site [20–23] . Aside from thermal cauterization, corneal injury can also be introduced by using alkaline chemi-
cals, for example silver, potassium nitrate, or sodium hydroxide [ 6 , 24 , 25 ]. Similar to thermal injury, burns caused by these alkalis can
induce leukocyte infiltration and, therefore, stimulate vascular formation [ 21 , 26 ]. Compared to other corneal (lymph-)angiogenesis 
models, thermal cauterization does not require complicated tools and preparation, thus is less expensive and less time-consuming. 
Nevertheless, it demands a skillful technique, mostly due to the small size of a mouse eye, as the limbal area may be damaged during
the cauterization process. We therefore introduced here a detailed, stepwise protocol including notes of caution at all critical steps,
enabling researchers unexperienced with this method to replicate the procedure, and overall to improve reproducibility and allow 

better comparison of results between different research groups. We focused this protocol on the investigation of (lymph-)angiogenic 
drivers for potential therapeutic purposes. For instance, this assay can be applied to assess the involvement of a specific gene/gene
product in (lymph-)angiogenesis by performing inhibitor-mediated target protein blockade (topical administration), siRNA-mediated 
gene knockdown (topical administration), viral vector-based gene delivery of anti-angiogenic factor (intrastromal or intraconjunctival 
injection) or using (conditional) knockout mouse models [ 12 , 13 , 15–17 ]. 

We describe in detail the analysis of blood and lymphatic vessel area (CD31 + and LYVE-1 + area as a percentage of the total
corneal area, respectively) and blood/lymphatic branch point density (number of blood/lymphatic branch points per mm 

2 ), which 
represent the main readouts of the assay. As alternative blood endothelial markers, the mouse neovascular endothelial cells can be
immunostained for CD34, CD102 or CD105, depending on availability or preference [27] . Similarly to blood ECs, other lymphatic
EC markers such as VEGFR-3 or podoplanin can be used as alternatives for immunohistology [3] . Other parameters relevant to
the (lymph-)angiogenesis process can additionally be assessed by appropriate histological staining ( e.g. Ki67 for proliferating cells, 
TUNEL or cleaved caspase-3 for apoptotic cells [ 28 , 29 ]). Aside from probing corneal (lymph-)angiogenesis at one (final) stage us-
ing histological staining, intravital imaging tools such as slit lamp photography, confocal microscopy (with the use of fluorescent 
reporter mice), or optical coherence tomography can be utilized to record the (lymph-)angiogenic process dynamically over time 
[30–32] . As thermal cauterization induces an inflammatory response, this model is also suitable to assess the immune response dur-
ing (lymph-)angiogenesis in different experimental conditions. For instance, the roles of macrophages, dendritic cells, Th17 helper 
cells, which are recruited to the injured cornea as a part of innate immunity and thereby induce (lymph-)angiogenesis, can be inves-
tigated by immunohistochemistry or immunofluorescence stainings for appropriate markers [ 11 , 23 , 33 ]. 

In conclusion, this ocular (lymph-)angiogenesis assay represents a feasible and reproducible model to investigate 
(lymph-)angiogenesis-related processes and mechanisms in vivo, and an important tool to evaluate (lymph-)angiogenic responses 
in preclinical settings. 
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